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I. TRANSFER RECORDS TO ANOTHER DIRECTORY

A. Overview

1. What is the Transfer
Records to Another
Directory function?

2. Why would | need to
transfer records to another
directory?

3. Can |l transfer records in the
associated modules from
one directory to another?

4. When do | create and use a
holding directory?

5. How do I create a holding
directory?

B. Transferring Records to
Another Directory

1. What steps do I follow to

transfer records from one
directory to another?

2. How do | select the records
to transfer?

ICMS User Manual (2015)

The Transfer Record(s) to Another Directory function allows you to copy
any records from one directory to another directory of the same type. You
can copy a single record, a group of selected records, or the entire directory.
You may want to create a holding directory for records that you have not yet
approved for inclusion in your main directory. Then transfer them to the
main directory when you are sure they are accurate and complete.

Yes. The Transfer Records(s) to Another Directory function is available in
all modules and associated modules.

Use holding directories to:

e keep an individual cataloger’s work in one directory for review

e separate a contract cataloger’s work for review before acceptance

e accept imported records and check them before moving them to your
main database.

Refer to Chapter 9, Tools, for instructions on creating directories.

Transferring records is a multi-step process. You must:

e Activate a tag set, quick filter, advanced filter or select multiple records
in the List Pane if you wish to transfer only a portion of your records.

o  Transfer the selected record(s) or the entire directory.

e  View records in their new directory.

e Delete the records in the holding directory.

Go to the directory that holds the record(s) you want to transfer.
If you want to transfer... Then...

only one record in your holding  go to the record that you want to transfer
directory,

some, but not all the records in activate a tag set, filter or select multiple
your holding directory, records in the List Pane of only the
records you wish to transfer

all the records in your holding do not activate any subset of your data.
directory,
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If you want to transfer all the records in a directory, you do not need to
activate a tag set or any other subset. The Transfer function includes the
option to transfer all visible records which is all records in the table if no
subset is activated.

3. Where is the Transfer
Records to Another
Directory function located?

4. How do | transfer records to
another directory?

Transfer To

Moving & Sharing Data/
Transfer Records to Another Directory

Refer to Chapter 7, Finding and Grouping Records, for information on tag
sets, filters and selecting multiple records.

To get to the Transfer Record(s) to Another Directory function, you must be
viewing records in a directory, then:

e  Select Transfer on the File menu.

e  From the Transfer submenu, select Transfer Record(s) to Another
Directory.

If you want to transfer only certain records, activate a tag set, filter or select
multiple records in the List Pane first, then:

Select Transfer Record(s) to Another Directory on the Transfer submenu
from the File menu, the Transfer Records screen appears.

2 Transfer Records Q@El

Set transfer options

Transfer Ta:

DI - Culkural Resources
WORE - Culbural Resources

Transfer Scope:

&) Selected Ikem{s) ) All Wisible Items

If record already exists in the destination. ..

#) Ignore duplicate record
) Update the target record
) Add a duplicate record

Transfer Cancel

The Transfer To box contains a list of your other directories of the same type.
Single-click on the directory to which you want to transfer records.

Note: If you are transferring Cultural Resources catalog records, the list of
directories will only show other cultural resources directories available in
your system. However, if you are transferring records from an associated
module, the list of directories will include all other directories that have the
same associated module type available. For example, you can transfer Loans
Out records from a Cultural Resources directory to a Natural History
directory if desired. But you cannot transfer Cultural Resources catalog
records to a Natural History directory.
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Transfer Scope

If record already exists in the
destination

5. What must | do after the
records are transferred?

ICMS User Manual (2015)

Use the Transfer Scope options as follows:

e Selected Item(s) — Choose this option if you only want to transfer a
single record, or you have multiple records selected in the List Pane.
This option will only transfer the record(s) that is highlighted in the List
Pane. To select more than one record in the List Pane, use Shift-Click or
Ctrl-Click. (See Section VII of Chapter 7 for information on how to
select multiple records in the List Pane.)

e All Visible Items — Choose this option if you want to transfer the entire
contents of the directory, or the entire contents of a tag set, quick filter or
advanced filter that is active.

Be careful if you choose All Visible Items. If you do not want to transfer
the entire contents of the directory, you should activate a tag set, quick
filter or advanced filter before you choose this option.

The Transfer records to another directory function includes a check for
duplicate records. At the bottom of the transfer records screen, you can
choose an action to take for duplicate numbers or key identifiers (e.g.,
catalog number, accession number, loan ID, name ID, etc.). The action that
you choose affects all the records that you are transferring. Choose between:

e Ignore duplicate record — Choose this action if you don’t want to
transfer duplicate records.

e Update the target record — Choose this action if you want the records
you are transferring to overwrite the records in the destination directory.

e Add a duplicate record — Choose this action to create duplicate records
in the destination directory.

To select your choice, click on the button in front of the action.
After making your choices, click Transfer.
Click Yes to the Are you sure message.

Once the records are transferred, you will receive a confirmation message of
how many records were transferred or ignored. Click OK.

After transferring the records:
Check the records in their new directory to make sure that they are all there.

Then, delete the holding directory and all its records.

If you want to delete... Then use the...
the holding directory and its Delete a Directory utility.
records,

the records and use the holding go to Edit on the menu bar and choose

directory again, Delete. Then choose Delete Multiple
Records if you have a tag set, filter or
multiple record selected in the List Pane.
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The Transfer Records to Another Directory function copies the records
from one location to another. It doesn’t delete them.

Refer to Chapter 9, Tools, for instructions on deleting a directory.
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Il. TRANSFER RECORD(S) TO/FROM DISK

A. Overview

1. What are the Transfer
Records To and From Disk
functions?

2. Why would | need to
transfer records to or from a
disk?

3. Will the Transfer Records
external file include catalog
and associated module
records from the directory?

4. Can | transfer selected
records only?

B. Transfer Record(s) To
Disk

1. What steps do I follow to
transfer records to disk?

2. How do I select the records
to transfer?

ICMS User Manual (2015)

The Transfer Records To Disk allows you to copy your records to an external
file. This file can be used to load the data into another computer by using the
Transfer Records From Disk function.

You may want to use the Transfer Records To or From Disk functions so you
can:

e load records onto a stand alone machine such as a laptop

e send records to another unit or center

e send records to a contract cataloger as examples of cataloging
e receive records from contract catalogers

e receive records from another unit or center

No. The Transfer Record(s) to Disk will only include data from one table
(catalog records or accession records or loan records, etc.). But you can use
this function in any associated module to send or receive just those records.

Yes. You can select records to transfer to disk by activating a tag set, quick
filter, advanced filter or selecting multiple records in the List Pane. You can
also transfer all records if you wish.

To transfer records to disk, you must:

e Activate a tag set, quick filter, advanced filter or select multiple records
in the List Pane if you want to transfer a selected group of records.
Otherwise you can only transfer the current record or all records.

e Select a location to save the resulting zip file.

e  Transfer the records.

Go to the directory that holds the record(s) you want to transfer to disk.
If you want to transfer... Then...

only one record in your holding  go to the record that you want to transfer
directory,

some, but not all the records in activate a tag set, filter or select multiple
your holding directory, records in the List Pane of only the
records you wish to transfer

all the records in your holding do not activate any subset of your data.
directory,
8:5 Moving & Sharing Data/
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3. Where is the Transfer
Record(s) to Disk function
located?

4. How do | Transfer Records
to Disk?

What to Transfer

Moving & Sharing Data/
Transfer Records To/From Disk

If you want to transfer all the records to a disk, you do not need to activate
a tag set or any other subset. The Transfer Record(s) to Disk function
includes the option to transfer all visible records which is all records in the
table if no subset is activated.

Refer to Chapter 7, Finding and Grouping Records, for information on tag
sets, filters and selecting multiple records.

To get to the Transfer Record(s) to Disk function, you must be viewing
records in a directory, then:

e Select Transfer on the File menu.

e From the Transfer submenu, select Transfer Record(s) to Disk. The
Transfer Records to Disk window will open.

& Transfer Records to Disk - Catalog Records

Transfer Records to Disk

Verify options and click 'Start Transfer' to create a transfer zip file. vou can use the
resulting zip file in another systemn or directory by utilizing the 'Transfer Records from
Disk' menu option.

what to transfer:

#) Current Record
) Selected 10 records

Location to save the transfer zip file:

Browse

|v] Use default transfer zip filename

Default transfer zip filename:

Start Transfer Cancel

If you want to transfer only certain records, make sure you have activated a
tag set, filter or selected records in the List Pane. Then, to Transfer Records
to Disk:

Choose Transfer Record(s) to Disk on the Transfer submenu located on the
File menu.

You have two choices for what records you want to transfer to disk:

e Current Record — Choose this option if you want to send only one
record to an external file. The record transferred will be the one
currently highlighted in the List Pane and shown in the Record Pane.

e Selected ## records — Choose this option to transfer a group of records
to an external file. The number will indicate how many records are
currently selected. This number could represent all records in the
directory, the contents of a tag set, quick filter, advanced filter, or the
number of records highlighted in the List Pane if more than one are
highlighted.
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Location to save the transfer zip
file

Use default transfer zip filename

C. Transfer Record(s) from
Disk

1. Do I have to be in the
directory where | want to
load the records?

2. Do I have to be in the same
associated module that
matches the incoming
records?

3. Where is the Transfer
Record(s) from Disk function
located?

ICMS User Manual (2015)

Enter the location where the resulting file will be stored. The default
location is usually “My Documents” on your computer. You can select a
different location by clicking Browse.

When this option is checked, the program automatically names the resulting
file in the following format:

Transfer-name of submodule-current date.zip
Note: The name of submodule will be Objects for catalog records, Access
for accession records, Exhibt for exhibit records, etc., depending on the type

of records you are transferring.

If you want to enter your own file name, uncheck this option and a new entry
box for the file name will appear for you to enter a new file name.

After selecting your options, click Start Transfer to send the records to an
external file.

Once the records have been transferred, click OK on the confirmation
message.

The resulting zip file is now available to send in the location you selected.

No. The Transfer Record(s) from Disk wizard allows you to select the
directory where you want to load the records.

No. You do not have to be in the matching associated module or catalog
records to Transfer Record(s) from Disk. You can be in any associated
module or catalog records of any directory.

You can only use the Transfer Record(s) from Disk function to load data
from a file created with the Transfer Record(s) to Disk function in another
Re:discovery system.

To get to the Transfer Record(s) from Disk function, you must be viewing
records in a directory, then:

e  Select Transfer on the File menu.

e  From the Transfer submenu, select Transfer Record(s) From Disk. The
Transfer Records From Disk wizard will open.
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4. How do | Transfer Records

from Disk?

Moving & Sharing Data/
Transfer Records To/From Disk

X Transfer Records From Disk - Select Zip File

Transfer Records From Disk

Select the incoming transfer zip file, These files bypically have a name like "Transfer-[Table]-
[Date].zip'.

CIB&

R

Select the incoming transfer zip file:

Browse

Cancel ext =

To transfer records from a transfer zip file:

On the first page of the Transfer Records from Disk wizard, type the
path and file name of the incoming transfer zip file, or click Browse to
locate and select the zip file. This file must be a valid zip file created
using Re:discovery’s Transfer Record(s) to Disk function. No other file

types can be loaded with this feature.

After selecting the file, click Next.

& Transfer Records From Disk - Select Destination Directory

Transfer Records From Disk

Select the directory to transfer ta From the list below, Use the 'Create Mew Directary’ link ko
create an empty directory of the correck bype,

Incoring directory type: Cultural Resources

Select the destination directory:

PARK - Cultural Resources

PARK - Matural History

TEMP - Cultural Resources
es

Create hew Directary

| Cancel Il < Back Jl Next =

Select the destination directory. The system will show all available

directories into which you can load these records.
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Note: You can also create a new directory to load the records by
clicking Create New Directory at the bottom left (see Chapter 9, Tools,
for information on creating directories). This is recommended if you do
not want to overwrite existing records.

After selecting the destination directory, click Next.

Z Transfer Records From Disk - Select Module Data to Load E]@EJ

Transfer Records From Disk

Check the modules you want to load. Eé

Modules
Catalog Records

Duplicate records will be updated,

Check All Uncheck &l

| Cance\_J| <Back_J| Next>_J

The incoming data type will be selected. Click Next.

You will be asked to confirm the data transfer. The process can take a
long time if the zip file contains lots of records to load. Click Yes to
continue. The zip file will be extracted (un-compressed) and a report of
the transfer process will be prepared.
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2 Transfer Records From Disk - Verification

Transfer Records From Disk
Review the pending update actions to see how many records will be ignored, added, updated, Eé

and skipped For each module. IF records will be skipped, a printable report identifies these
recards. Click Cancel ko abort the update - no recards will be updated. Click Finish to complete
the update.

Pending Update Actions For TEMP - Cultural Resources

| Module Total Incoming Records  Ignore (no change)  Add U.pdate Skip (both changed)
} Catalog Records ' ] i i ]

| Cancel | < Back | | Finish

e The Verification window reports the total number of incoming records
and shows the number that will be added and the number that will be
updated. None will be ignored or skipped and no comparison of records
takes place.

There is no comparison between incoming and existing records. If a
duplicate record exists in the directory, it will be overwritten with the
incoming record. If you want the system to ignore the duplicates, create a
new directory, transfer the records into that directory, and then use the
Transfer Record(s) to Another Directory (see Section I in this chapter)
instead.

e  After verifying, click Finish.

¢  You will get a confirmation message when the transfer is complete.
Click OK.

Your records are now transferred into the directory.
Note: If you are currently in the table (catalog records, accessions, etc)
where you loaded the records, you will have to click the Refresh button on

the button bar or select Refresh from the Edit menu to see the newly loaded
records.
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lll. EXPORT LIST

A. Overview

1. What is the Export List
function?

2. What is the difference
between Export List and
Import/Export Selected
Fields?

3. What file formats are
available to export the fields
in the List Pane?

4. Where are the Export List
options located?

5. What is the Export Images
option?

ICMS User Manual (2015)

The Export List function allows you to export the data in the List Pane to one
of several file formats.

Note: You can change the fields that appear in the List Pane by using
Update My List View. See My List View under Chapter 7, Section V, Sorts.

The Export List function is a quick way to export just the fields you see in
the List Pane to a specific predefined format. You do not have to set up
templates as in import/export selected fields nor select field delimiters and
text indicators.

In addition, the file format you select for Export List is automatically created.
It does not create an ASCII delimited or CSV file that must be imported into
the desired program.

However, since Export List only exports the fields displayed in the List Pane,
the number of fields exported is limited. If you need to export many fields, it
is best to use Import/Export Selected Fields. See Section IV of this chapter
for information on Import/Export Selected Fields.

You can export the List Pane data into any of these file formats:

e  Microsoft Excel: a standard spreadsheet application. The data in the
List Pane will be exported to an Excel file, where the columns and rows
match the data you see in the List Pane. The column headers in the List
Pane will be used as in the first row of the Excel spreadsheet.

Note: Only data exported to Excel format may be imported back into
Re:discovery. However, we recommend using Import/Export Selected fields
if you are exporting data to an external file, and plan to re-import that data
later.

e HTML: a standard web-based document. The data from the List Pane
will be viewable as a table. You can open an HTML file by double-
clicking the file, or by opening the file in Internet Explorer.

e PDF: Portable Document Format, a common format for sharing
documents. You can open a PDF file using the Adobe Reader.

e Text: a simple non-delimited text file. You can open a text file with MS
Word, WordPad, or Notepad.

e XML: Extensible Markup Language. You can view an XML document
with Internet Explorer.

To access the Export List options, go to the File menu and choose
Import/Export. The various Export List options are available on the
submenu.

The Export Images option on the Import/Export menu is used to export only
the image files from the records in the List Pane. No record data is included
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with this option. It will create a file for each image attached to each record in
the location you specify. The file names will be the original names of the
files from when the image was attached to the record.

B. Exporting the List Pane

1. How do I export the fields To export the data in the List Pane:
and data visible in the List
Pane? e If you do not want to export your entire table, select a subset of your

data by activating a tag set, filter or performing a word search.

Note: You cannot use this function on a selection of data highlighted in the
List Pane. It will export all data regardless of what is highlighted.

e Ifnecessary, change the fields to the ones you wish to export by using
the Update My List View option on the View menu. Refer to Chapter 7,
Section V for information on My List View.

e  From Import/Export on the File menu, choose one of the following
Export List options:

Export List to Excel

Export List to HTML

Export List to PDF

Export List to Text

Export List to XML

Export Images (image files only)

Savein | (3 Temp # Q g

; 2 ;',_"5 Basket List.pdf

iy Recent
Documents

@ |

Desktop

_j |

My Docurnents

9 |

E
by Computer

)

P
- File name: |exp0rt.pdf v| Save
-:_J L )

MyNetwok | Saveastpe | PDF File ("pdi) v| [ canesl |

i

e Inthe Save As window, select the location where you wish to save the
file by using the “Save in:” box at the top. Click the pull down arrow to
select a different folder.

e  The file name of “export” is automatically entered in the File Name field

with the appropriate file extension for the format you chose. Change the
file name if desired, leaving the file extension as entered.
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e  Click Save to export the records and save the file.

Note: For the Export Images option, you simply select the folder where you
want the images to be saved and click OK.

2. Can |l export images with the Yes. If you have images showing in the List Pane, the thumbnail image will
Export List function? be exported along with the data fields only if you use the PDF file format.

Note: To display images in the List Pane, choose Show Images in List Pane
on the View menu.

Collections = PARK - Cultural Resources - Catalog Records
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If you want to export only the image files themselves, use the Export Images
option instead.

Tip: If you want to export the images and data to an Excel file, use Print
Preview for the List Pane instead. Make sure that the images are showing in
the List Pane first. In the Preview window, you can then use the export
document feature to save the preview as an Excel file. This will include the
images shown in the List Pane. See Chapter 5, Section II.C for information
on exporting the Print Preview list.
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IV. IMPORT/EXPORT SELECTED FIELDS

A. Overview

1. What is the Import/Export The Import/Export Selected Fields function allows you to transfer
Selected Fields function? information to or from your ICMS fields and other software applications.
2. When will | use the Use this function to:
Import/Export function?

e place data created outside ICMS into ICMS fields

e manipulate or share ICMS data in another format

Example 1: A subject area specialist comes to your unit to identify and
catalog artifacts. You can include the expert’s information in
the catalog record even if he/she is unfamiliar with ICMS. To
do this, use the Import/Export function together with the Pre-
allocate Records function to give the expert a set of fields to
complete.

Use the Pre-allocate Records function to create empty records
with sequential catalog numbers. Export these records into
whatever database or spreadsheet format that the specialist
uses.

When the specialist is done, import the records back into the
master database and make whatever additions are necessary.

Refer to Section VI of Chapter 6 for information on the Pre-
allocate Records function.

Example 2: Several local museums want to combine fields from your
museum records with theirs to create a combined database for
researchers. You can export your records to be combined, even
if the museums are using different cataloging programs.

Use the Import/Export function to create an ASCII delimited
text file of the records that you wish to provide to the collective

database.

Give the ASCII file and the delimiters you used to the person
combining the data.

The person receiving the file will be able to read your file in
any standard spreadsheet or database.

3. Which fields are available You choose the ICMS fields that you wish to export to other systems.
for export? Information created in other database systems can be imported into the
ICMS fields of your choice.

Note: Supplemental information cannot be exported or imported.
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10.

11.

12.

What kind of software
applications can accept my
information?

What formats are supported
by the Import/Export
function?

What is ASCII delimited
format?

What is ASCII csv format?

What is XML format?

How many fields will | be
able to import/export at a
time?

Does this function work with
memo fields?

Can | import or export
supplemental data?

Can | import or export
individual subfields of
formatted and repeating
formatted memos?

ICMS User Manual (2015)

Your exported information can be accepted by:
e spreadsheets
e databases

e word processing systems

Fields can be imported and exported in an ASCII delimited, ASCII csv, or
XML text format.

ASCII is the acronym for American Standard Code for Information
Interchange. ICMS can produce and accept records in ASCII text format.
The fields are separated or “delimited” with characters that you specify. You
choose other delimiters to tell which fields are text fields. Both the system
you are exporting to and the one you are importing from must recognize
these delimiters. Most databases support the import and export of ASCII
delimited text files.

ASCII csv format is also a delimited text file but the delimiters to separate
the fields and identify text fields are predetermined. The field delimiter is a
comma and the text indicator is a double quote. This type of file is mostly
used by Microsoft Excel spreadsheets.

XML (Extensible Markup Language) is a flexible way to create common
information formats and share both the format and the data on the World
Wide Web, intranets, and elsewhere. This type of file uses tagged indicators
to identify the fields in the export. You can view an XML document with
Internet Explorer.

You can import and export any number of fields. You may only choose
fields located in your current module or associated module. You are
therefore limited to the number of fields in your current module or associated
module.

Yes, this function works with memo fields.

Note: Data in memo fields may contain keyboard carriage returns at the end
of a paragraph or line. The system will substitute <CR> in your exported
data whenever it finds a carriage return in your ICMS data.

No, you cannot import or export data in the supplementals. However, if you
import location, condition or object status fields, the history tracking
supplementals for these will be updated using the Track Changes window
during import.

Yes, you can import and export data in individual subfields of formatted and
repeating formatted memos.

Note: For repeating formatted memos, the data from the subfield of each
entry in the grid will be exported with the repeating delimiter separating the
entries. E.g., when exporting the City subfield from the Origin field that has
3 line entries, the data will appear like this: “St. Paul ||Detroit ||Chicago”
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B. Exporting Fields in ASCII

Format
1. How do I access the You can access the Import/Export function from any collection or archive
Import/Export function? record or associated module.
To get to the Import/Export function:
e From File on the Menu Bar, choose Import/Export.
e On the Import/Export menu, choose Import/Export Selected Fields then
Import/Export Selected Fields again.
The Import/Export Records wizard appears.
& Import/Export Records
Import/Export Records
Do you wank to impott aor export daka?
') Export Records
| Cancel - | Mext = -
2. What steps do I follow to Exporting fields is a multi-step process. You must:
export fields from ICMS
records to another e Activate a tag set, filter or highlight several records in the list pane that
database? you wish to export. If you do not limit your visible data, you will export

all the records in your database. Refer to Chapter 7 for information
about tag sets and filters.

e C(Create an import/export template or choose an existing template using
the Import/Export wizard.

e  Export the fields using the import/export template.

Note: The template you create is used with your visible data. You choose
the fields and delimiters that you want. The system then creates the export
file using the currently visible data. The template can be used again and
again with different data.

The template you create can be used for ASCII text export, ASCII csv
export, and XML export.

Functions/Import/Export Selected Fields 8:16 ICMS User Manual (2015)



3. How do I export selected
fields?

Create a New Template
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e On the first page of the Import/Export wizard, select Export records and
click Next.

& Import/Export Records

Select a Template
Do you want ko use an existing template or create a new one?

&) Open an existing template

') Create a new template

| Cancel | <Back | Mext =

e Select one of the template options and click Next:

Open an existing template — allows you to select or modify a template
that has already been created. Templates can be used for both importing
and exporting records.

Create a New Template — allows you to set up a new template to select
fields to export.

Note: If you have an existing template that has most of the fields you want

to export, you can modify that template and add or remove fields as desired
and even save it with a different name.

When you click Next, the Create a New Template page opens. Complete the
fields as follows:
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Z Import/Export Records EI[EI@

Create a New Template }

Enter properties information For your template and map the incoming fields to Rediscovery fields, For figlds vou do not want
toimpart, select Skip, For data in specifice fields that you want ta append to existing catalog records {mema fields only), At
select Append For that Field,
Template Mame

Description
&) Allow others to view my template
i) Allow only me to view my template

Created by Last Madified by

Created an Last Modified on
Field mapping povelp  Move Down Insert  gppend  Delete

Rediscovery Field Skip For import. Append data for impork:
Zave Template |v] Use this template
| Cancsl J | < Back J | Mezt > J
Template Name

Enter a name for the template. You must enter a name or you cannot save
the template or export records.

Description
Enter a description of the template for your reference. This field is optional.

Allow others to view my template/
Allow only me to view my template
Select whether to allow others to use your template or only you.

Note: Created by, Created On, Last Modified by and Last Modified on are
system generated using your user id and current date.

Field Mapping
To add fields to the template:

e Click Append. A new line appears in the grid.

e  Choose the field name from the pull down menu in the
Rediscovery Field column.

e Add all fields desired in this manner. Each time you click Append
a new line appears at the bottom. You can also click Insert to add
a field above the field selected in the grid.

Note: It is recommended that the catalog number or main identifying field
such as Artist name or Loan ID be the first field in your template. The
remaining fields in the template can be in any order for exporting. Use the
Move Up, Move Down, Insert and Delete options to arrange or remove the
fields in the template to match the incoming data.

Tip: You can export individual subfields of formatted or repeating formatted
memo fields. The subfields will be listed in the pull down menu with their
main field name preceding the subfield name. For repeating formatted
memos, the exported data will have the repeating delimiter (space-pipe-pipe
(|D ) inserted between each entry from the grid — e.g., “City A ||City B”
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Open an existing template
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I You cannot change the Rediscovery field label that exports with the data.

Note: The “Skip for import” and “Append data for import” check boxes next

to the fields are for importing data only. See Section C below.

Save Template
When finished adding fields, click Save Template. If you do not save the

template, when you click Next the system will prompt you to save the
template.

Use this template

You can create multiple templates that you may not want to use for exporting
data. Uncheck this option if you do not want to use this template for
exporting the current data. When you click Next, you can then select or
create another template to use instead.

The following page will appear when you click Next allowing you to select
the template.

Re| Import/Export Records

Select a Template

Select an existing template from the list,

® Hhon
') Showe &l Templates

Add Template  Modify Template Delete Template

Format Hame Date Created  Description
3 location impart R =<t locatin update
datain S117/2006 Park data

Template Summary | Catalog #, Condition

L Canc;\_J‘ <Baci<__Jl Mext >_J

Select to show only your templates or all templates by choosing one of these
options:

Show Only My Templates — lists only those templates created by you.
Show All Templates — lists all shared templates in the directory.

The list of templates appears in the grid.

Template Summary
This field shows the list of fields that are included in the selected template.

Add Template
You can add new templates from this page by clicking the Add Template

option.
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Modify Template
This option allows you to modify the selected template to change fields or
description.

Delete Template
This option will permanently delete the selected template.

e  After selecting or creating a new template as described above, click
Next. The Export Records Output page will appear.

& Import/Export Records

Export Records Output
Choose the file bype you want o export to and then enter the path and file name of the output file of

click Browse, Mote: Some file tyeps do not support fields longer than 250 characters

File Type: V]

Export File: | EBrowse

| Cancel | <Back | Mext =

e File Type: Choose the type of export file you want to create by
choosing one of two options from the pull down menu.

ASCII delimited — a text file (.txt) that you specify the field delimiter
and text qualifiers. This is recommended if the data contains
commas or double quotes so that you can select different symbols.

ASCII ¢csv — a comma delimited file (.csv) (used primarily by
Microsoft Excel©). You do not have a choice of field delimiter or
text qualifier for this format. It is always a comma and double quote,
respectively. Do not use this format if your data contains commas or
double quotes.

XML -- a tagged text file (.xml) that can be opened in Internet
Explorer. There is no field delimiter or text qualifier for this format.

e Export File: Enter a path and file name for the export file, or click
Browse to select a location and enter a file name.

Note: If you do not enter a path with the file name, the file will be saved in a
pre-selected location. You will be notified of this location once the export is
complete.

e  Click Next after entering the file type and export file name.
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I Import/Export Records

Export Text Wizard
Chaoose the figld delimiter and text indicator. Select whether to include Field names on the first row. See how your text is affected
in the preview below,

JTab ) Semicolon ) Comma ) Space (&) Other [~
Text Qualifier '

Sample Size 10 5

'PARK  22222'~WESSEL, CERAMIC'~'DRAFT RECORD'~'SWRO ACC 1 OSFT BLDG SWRO LOBEY'
| PARK SE78Y'~RUGEXHIEIT~ around here!

'PARK  67890'~Basket'~'EXHIBIT'~'over there'
I 'PARK 98765 ~'CHAIR'~'EXHIBIT'~'Storage’

| cancel J‘ « Bark J| Naxt>_J

e  Select the Field Delimiter you want to separate the fields. You have a
choice of Tab, Semicolon, Comma, Space or you can enter a character
by selecting Other and typing the character in the field.

e  Then enter a Text Qualifier (if desired). The Text Qualifier can be any
character.

Note: If you are exporting to an ASCII csv or XML file type, the Field
Delimiter (comma) and Text Qualifier (“) will already be selected for you.
You cannot change these for a csv or xml format.

Tip: If you need non-keyboard characters for the Field Delimiter and Text
Qualifier, right click in the Other field or Text Qualifier field and choose
Extended Character Set to select an ASCII character.

The grid will show a sample of records from the data you are exporting. You
can change the sample size by increasing or decreasing the number.

Notice how the sample of the data changes when you select the field
delimiter and text qualifier.

Tip: If your data contains commas, double quotes, spaces, etc., you should
choose a field delimiter and text qualifier that do not exist in your data.

Some useful characters for this purpose which generally do not appear in
your data are the tilde (~), pipe ( | ), carat (), and plus (+).

e  Click Next after making your selections.
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4. How do I import this file into

C.

1.

another format?

Importing Selected Fields

How do I access the
Import/Export function?

& Import/Export Records

Export Process Reporting

Please review the summary report of impaorted recards,

| Start Expork

Records Exported

| Cancel | =Back ] | Finish

e  Click Start Export to export your data. You will be asked to confirm
the export. Click Yes.

e  When the export has finished, a message will appear indicating the path
and name of the export file and the number of records exported. Click
OK. The number of records exported will also be displayed on the page
above.

e  Click Finish to close the Import/Export wizard. The export file is now
available in the location you selected.

Check the manual for the program into which you are importing the data. It
should tell you how the program imports ASCII delimited, csv or xml text
files. Most XBASE databases have instructions on how to import data. Most
Windows-based programs will prompt you when you attempt to open the

file.

If done incorrectly, the import process can damage your existing ICMS
data records. If the records being imported are new, it is recommended that
you establish a “holding” directory to receive imported data. Use the
Create a New Directory option (Chapter 9, Tools) to create a holding
directory. This will let you check that the data were properly imported
before you transfer the data to your main collection directory.

If the incoming records will be updating selected fields of existing records,
it is recommended that you make a backup of your main directory first.
Use the Backup Data option (Chapter 9, Tools) to make a backup of your
directory before you begin.

You can access the Import/Export function from any collection or archive
record or associated module.

To get to the Import/Export function:

Functions/Import/Export Selected Fields 8:22 ICMS User Manual (2015)




e From File on the Menu Bar, choose Import/Export.

e On the Import/Export menu, choose Import/Export Selected Fields then
Import/Export Selected Fields again.

The Import/Export Records wizard appears.

& Import/Export Records

Import/Export Records
Do you wank to impott aor export daka?

') Export Records

| Cancel | Mext =

2. What steps do I follow to Importing fields is a multi-step process. You must:
import data from another
database into ICMS? e  First, export or save the data from the other database into an ASCII

delimited text file (file with a .txt extension) or “comma separated
value” file (file with a .csv extension). In Microsoft Excel, you can use
the File, Save As... option. In Microsoft Access, you must “export” the
file to one of those formats. For help, use the instructions or help
provided with the other database program you are using.

e Create an import/export template or choose an existing template using
the Import/Export wizard.

e Import the fields using the import/export template.

You create or choose the import/export template that you want to use to
import data. When you choose or create your import/export template, make
sure that:

e  The first field in your import/export template and the first column in the
file you are importing are the unique key field for the data you are
importing. For ICMS catalog records, Catalog # should always be the
first field in your template and the first column in the file you are
importing.

e  The import/export template has the same number of fields as the
incoming data
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e The fields in the incoming data and import/export template are in the
same order.

e The field labels in the incoming data match the import/export template
field labels exactly.

Note: There is an easy way to ensure that your import format will match the
ICMS database structure. Create an export format with the data fields you
need. Use it to export a small set of data to the other application (the one you
want to import data from later). Make sure that the data you will import
matches the structure of this small export file.

3. How do I import selected e  On the first page of the Import/Export wizard, select Import records and
fields? click Next. On the Import Records page that appears, select the
incoming data file and type.

& Import/Export Records

Import Records
Choose the file bype you want to import and then enter the path and file name to be imported or click
Browse to locate the import: file
File Type: V]
Import File: | Browse
| Cancel | =Back | Mext =
File Type

Select the type of file that you are importing from the pull down menu for
File Type. You have two choices:

ASCII delimited — a text file (.txt) with field delimiter and text qualifier
exported from another program such as Microsoft Access©.

ASCII csv — a comma delimited file (.csv) usually exported from
Microsoft Excel©.

Import File

Enter the path and file name of the import file, or click Browse to locate and
select the file. Note: The type of file you choose in File Type determines
the file types shown in the Open dialog box when you click Browse.

e  Click Next after making your selections.
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= Import/Export Records

Import Text Delimiter

What Field delimiter and kext indicator ate used in your data? Does wour File contain the Field names in the first row? Select the
appropriate options and watch how your data is affected in the preview below. Mote: the first column must contain the Record 10,
Catalog Murmber or key Field {.g., Mame in Artist, Exhibit 1D in Exhibits, etc.).

JTab () Semicolon () Comma ) Space = Biferd [~

Text Qualifiar "

sample Size 105
Catalog # Dhject Chiject status Location
y FOBU 287 ek E # |1 ]
FOBL 288 TRUME STORAGE Lacation imparted
FOBL 289 TRUMK STORAGE Vault 13, imported
FOBU 291 BOX, TOBACCO STORAGE Drawet 55, imparted
FOBU 300 HAMMER, SLEDGE STORAGE Cahinet A, drawer 13, i...

FOBL 310 BOME, RIE STORAGE Shelf 5, imported

| Cancel |__<Back JI Mext = J

e Ifyou are importing an ASCII delimited file, choose the Field Delimiter
that was used to separate the fields.

e  Enter the Text Qualifier that was used to indicate text (if any).

The delimiters in the Field Delimiter and Text Qualifier must match the
delimiters used in the incoming data file you are importing.

Tip: If you need non-keyboard characters for the Field Delimiter and Text
Qualifier, right click in the Other field or Text Qualifier field and choose
Extended Character Set to select an ASCII character.

Note: When importing ASCII csv files, you do not need to select the Field
Delimiter and Text Qualifier. These are automatically set as Comma and
double quotes (), respectively, and cannot be changed.

A sample of your incoming data is displayed. You can increase or decrease
the number of records shown by changing the number. Watch how the
columns and data change when you select the correct field delimiter and text
qualifier.

e  (Click Next.
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= Import/Export Records _l |E| fgl

Select a Template

Do yiou want bo use an existing template or create a new one?

&) Open an existing template
') Create a new kermplate

| Cangel Jl < Back Il Mexk =

Choose whether to open an existing template or create a new template
and click Next

Open an existing template — allows you to select or modify a
template that has already been created. Templates can be used for
both importing and exporting records. It is not necessary to create new
templates if the format of the incoming data is the same as a
previously imported or exported file.

Create a New Template — allows you to set up a new template to
match the field order of incoming data.

Create a New Template When you click Next, the Create a New Template page opens. Complete the
fields as follows:

Functions/Import/Export Selected Fields

Z Import{Export Records

Create a New Template
Enter properties information for your template and map the incoming fields to Rediscovery fields. For fields you

do not want toimport, seleck Skip, For data in specifice fields that vou want ko append ko existing catalog
recards {memo fields only), select Append Faor that Field.

Import File Columns: Catalog #, Object, Object Status, Location,

Template Mame

Description

&) Allow others to view my template
J Allows anly me ta view my kemplate

Created by Last Modified by
Created on Last Modified on

Field mapping Movelp  Move Down fppend  Delste

Rediscovery Field [ Skip For import I Append data for import

Save Template ] Use this kemplate

Cancel | =Back
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Template Name
Enter a name for the template. You must enter a name or you cannot save
the template or export records.

Description
Enter a description of the template for your reference. This field is optional.

Allow others to view my template or
Allow only me to view my template
Select whether to allow others to use your template or only you.

Note: Created by, Created on, Last Modified by and Last Modified on are
system generated using your user id and current date.

Import File Columns
This shows the labels and order of the fields of the incoming data to aid in
adding fields to your template.

Field Mapping
To add fields to the template:

e Click Append. A new line appears in the grid.

e  Choose the field name from the pull down menu in the
Rediscovery Field column.

e Add all fields necessary to match your incoming data. Each time
you click Append a new line appears at the bottom. You can also
click Insert to add a field above the field selected in the grid.

Note: Field order is important. The catalog number or main identifying
field like Artist name or Loan ID must be the first field in your template as
well as your incoming data. The remaining fields in the template must match
the order in your incoming data. Use the Move Up, Move Down, Insert and
Delete options to arrange the fields in the template to match the incoming
data. The Import File Columns listed above the Field mapping is there to
assist you with the order of the fields in your incoming data.

You cannot change the field labels in the template. If your incoming data
labels do not match the Rediscovery field labels, you must change the
incoming data labels before importing.

You can import individual subfields of formatted and repeating formatted
memo fields. The subfields are listed with the main field name preceding the
subfield name in the field list.

For repeating formatted memos, the data will be inserted into the first grid
entry of the repeating formatted memo unless you use the repeating delimiter
— space-pipe-pipe ( ||) — between the terms to divide them into additional
grid entries. For example,

Example 1:

Field: Origin: City

Incoming data:  ““||Denver |[Fort Collins”
Result:
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ity Caunty State Caunkry A

R
ala] LS4,

e

Denver Dernver

Fort Collins

The first grid entry subfield is blank, “Denver” is entered for the second
entry’s subfield and “Fort Collins” for the third entry’s subfield.

Warning: This will blank out the subfield if you do not enter a term. It does
not just skip over it.

Example 2:

Field: Origin: City

Incoming data:  “Boulder”

Result:

Caunty State Caunkry A
-- O

Denver Denver e Usa d
Fort Collins o |

The first grid entry subfield will be “Boulder” leaving the remaining entries
alone.

Skip for import

If checked, it will not import this field during the import process. There may
be some occasions where the incoming data has fields that you do not want
to import, but you must include them in the template as a ‘place holder’. Use
this option to ignore this field during import.

Append data for import

If checked, this option will append the incoming data to the field of a
matching record instead of overwriting the data in the current record. This
option is only available for memo fields. Note: Do not use this option for
formatted or repeating formatted memo fields.

Save Template
When finished adding fields, click Save Template. If you do not save the
template, when you click Next the system will prompt you to save it.

Use this template

You can create multiple templates that you may want to use later for other
data. Uncheck this option if you do not want to use this template for the
current data. When you click Next, you can then select or create another
template to use instead.

Open an existing template Select “Open an existing template” on the Select a Template page. The
following page will appear when you click Next allowing you to select the
template to modify.
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Re| Import/Export Records

Select a Template
Select an existing template from the list,

CFi
') Showe &l Templates

Add Template  Modify Template Delete Template

Format Hame Date Created  Description
Iocation import 5172006 testing location update
datain S117/2006 Park data

Template Summary | Catalog #, Condition

L Canc;\_J‘ <Ba?k_Jl Next>_J

Select to show only your templates or all templates by choosing one of these
options:

Show Only My Templates — lists only those templates created by you.
Show All Templates — lists all shared templates in the directory.

The list of templates appears in the grid.

Template Summary
This field shows the list of fields that are included in the selected template.

Add Template
You can add new templates from this page by clicking the Add Template

option.

Modify Template

This option allows you to modify the selected template to change fields to
match your incoming data.

Delete template
This option will permanently delete the selected template.

e Once you have created or modified a template, click Next. If the
template you are using does not match the incoming data, you will
receive a message that it does not match. Click OK and modify the
template to correct the field order or add missing fields, or select or
create another template to match.

e  If the template matches the incoming data, you will have the following
options concerning duplicate records:
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= Im port{Export Records

Duplicate Target Record
What do vou want ko do iF a matching recard is Found?

#) Update the target record {updates the matching record if Found)
' Ignore the duplicate {data is skipped if matching record Found)
) Add a duplicate record

| Cancel I[ < Back I[ hext =

Update the target record
If a matching record is found, the incoming fields will be updated in the
record. Any records without a match will be added to the table.

Ignore the duplicate
If a matching record is found, it will be skipped and no fields will be updated
for that record. Any records without a match will be added to the table.

Add a duplicate record

Adds all the incoming data to the table without updating matching records.
This option will result in duplicate records if the incoming data has the same
main identifying number as a current record.

Select one of these options and click Next.

Functions/Import/Export Selected Fields

Z Import/Export Records

Import Process Reporting
Please review the summary report of imported records,

| Start Ipart

Import File Records Read
Records Added

Records Updated
Records Skipped

Skipped Items

| Cancel | <Back | Finish

Click Start Import to begin importing the data.

8:30 ICMS User Manual (2015)



4. Can | transfer Import/Export
templates to another
directory?
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*  You will be prompted to enter Track Changes supplemental information
for Catalog Notes and any imported fields that have a history tracking
feature such as Location and Condition. Enter the appropriate
information and click OK.

2 Track Changes g@@l

Enter/verify values to help track changes.

Entries will apply to all applisable recards.

LOCATION Supplemental Information [IDo Mot Update

REASON PERMANENT LOCATION [¥]

AUTHORIZED BY Curator \ad Manually updats value od

START DATE T use automatic valus [~

LOGATION

CATALDG NOTES Supplemental Information [IDa Mot Update

CATALDGER Use automatic value d

LEVEL 1d| Manualy update valos o]

Use automatic valus [©]

Use altamatic value [~]

Note: These are the only supplementals that will be created during
importing. You cannot import data directly into a supplemental record.

*  You will get an “are you sure” message — click Yes. When complete,
you will get a confirmation message of the number of records imported —
click OK. The records imported will be reported as follows:

Import file Records Read
Indicates how many records were identified in the incoming data file.

Records Added
Indicates how many new records were added to the table.

Records Updated

Indicates how many existing catalog records were updated with the incoming
fields. Only reported if Update the target record was selected on the previous
page.

Records Skipped

Indicates how many incoming records were skipped because the record
matched an existing record in the directory. This is only reported if Ignore
the duplicate was selected on the previous page.

Skipped Items

If records were skipped during the import because you chose to Ignore the
duplicate, a list of these skipped records is shown in this grid.

e  Click Finish to close the wizard.

Yes, you can transfer Import/Export templates from one directory to another
in the same system or from one system to another.
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Transfer Template(s) to
Another Directory

Functions/Import/Export Selected Fields

Note: Import/Export templates can only be transferred into like
modules/directories as the one they are created in. For example, if you create
a new import/export template in a Cultural Resources style directory, you
may only transfer it into another Cultural Resources style directory.

To transfer Import/Export templates to another directory in the same
installation:

e  On the File menu, select Import/Export = Import/Export Selected Fields
—> Transfer Template(s) to Another Directory.

Edit View Record Tools Help
Import/Export »

Import/Export Selected Fields » Import/Export Selected Fields
[ Print Preview Export List to Excel Transfer Template(s) to Another Directory
& Print List Export List to HTML Transfer Template(s) to Disk
Launch E-Mail Export List to PDF Transfer Template(s) from Disk
S Backup Data Export List to Text

Restore Full System Backup Export List to XML

Data Updates (formerly Laptop Copy) » Export Jmages

FEWRITER, MANUAL G
PARK 5 BASKET ]

Load to Empty Directory

e  Alist of your existing import/export templates will display.

r = Bl
E Re:discovery Transfer Import/Expart Template(s) to Another 5 - Select i rt... @é‘g

Transfer Import/Export Template(s) to Another Directory

Selecttheimport/export templates to transferto another directory. E

Template Mame
» :ARIMPORT

| Condition import
EXPORT
Research data

| Canoﬂi | Next>7

Highlight the import/export template you want to transfer. You may
select multiple import/export templates by holding down the CTRL key
and clicking on additional ones until you have highlighted all desired
import/export templates.

Click Next.
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E Re:discovery Transfer Import/Export Temp!

Transfer Import/Export Template(s) to Another Directory

Tell Proficio whatyouwould liketo do if aimportfexport template with the same Import/Export |
Template Name already exists. If you select"Ignare Duplicate Import/Export Template”, the

programwill not transferin theimport/exporttemplate. Ifyou select "Update the Target
Import/Export Template” the programwill replacethe existingimportfexporttemplatewith the
import/expart template fromthe source directory.

(&) Ignore Duplicate Import/Export Template

| () Update the Target Import/Export Template

e Select the destination directory. Note: the program will only list the
available directories of the same style in the same module as the
directory you are transferring from.

e Then select an option for duplicate import/export templates (i.e., ones
that may already exist in that directory with the same name as those you
are transferring in). You can either ignore duplicate templates or update
existing templates that have the same name.

e  (Click Next.

e  The program will display a summary of the import/export templates
being brought in, including their names and whether they will be newly
added or updated.

r
fe:| Re:discovery Transfer Import/Export Templa

Transfer Import/Export Template(s) to Another Directory

[
Review the pendingupdate actions to seewhich import/export templates will beadded,
ignored, and updated. Clickcancel to abortthe update -no importfexport templates willbe
added/updated. ClickFinish to complete theupdate.

(e Total
tal iﬁccﬁ\ng‘lhmrﬂ%xmri:I'émpl-aﬁés
' MNew Import/Export Template Added
port/Export Template Ignored
port/Export Template Updated

o)

ol aln

| Template Name « | status

na\ﬁon import New I&pﬂhElmtTﬂnﬁateMd?d

| Research data New Import/Export Template Added | Print Report

e  Click Finish. Your import/export template(s) will be available for use in
the other directory.
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Transfer Template(s) to Disk

To transfer existing Import/export templates from one copy of ICMS to

another:

Functions/Import/Export Selected Fields

On the File menu, select Import/Export = Import/Export Selected Fields
- Transfer Template(s) to Disk. A list of your existing import/export
templates will display.

=
E| Rexdiscovery Transfer Import/Export Template(s) to Di =l
Please select the Import/Export Template(s) to transfer to disk.
Template Mame -

» ARIMPORT
Condition impart
EXPORT
Research data

Start Transfer Cance|

Highlight the import/export template you want to transfer. You may
select multiple import/export templates by holding down the CTRL key
and clicking on additional ones until you have highlighted all desired
import/export templates.

Click Start Transfer

New folder

Organize +

@ Documents -
JW Music

[&5] Pictures

B videos —

Mo items match your search,

#d Homegroup =

.- Computer —
()]
—a My Book (D)

File name:  Transfer-IETemplates-06-14-2015.CR_IE_tmplt -

Save as type: | CulturalResources Import Export Templates (*.CR_IE_tmplt) - ]

“ Hide Folders i Save i [ Cancel ]

Select the location to save the file as desired. You may keep the default
File name or change it, but you MUST leave the default Save as type.
Then click Save.

Re:discovery for the U.5, Department of the Interior: IC-..M

@ Transfer Complete
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e  When the transfer is complete, click OK.

Transfer Template(s) from e In the ICMS system that you want to transfer the import/export
Disk templates into, on the File menu, select Import/Export = Import/Export
Selected Fields = Transfer Template(s) from Disk.

— N
Red| Re:discovery Transfer Impart/Export Template(s) from Disk - Select Zip ﬁ\ew

Transfer Import/ Export Template(s) from Disk

Select the incoming updatezip file. These files typically have a name like "Transfer-
IETemplates-Date.CR_IE_tmplt"

Select the incoming transfer zip file:

Browse

Cancel - MNext > -

e Use the Browse link to navigate to the transfer file you created above
and select it. Then click Next.

_ 3
Re:| Rexdiscovery Transfer Impol‘lfbcp% Eéme_me(s) from Disk - Import owani_wlglﬂﬂg_

Transfer Import/Export Template(s) from Disk
Tell Proficio whatyouwould liketo do if aimp ort/export template with the same Import/Export E

Template Name already exists. If you select"Ignore Duplicate Import/Export Template”,the
program will nat transferin the importfexport template fromthezip file. Ifyouselect "Update

the TargetImport/Export Template”, the programuwill replacethe existingimportfexpart
template with theimport/exporttemplate from thezip file.

&) Ignore Duplicate Import/Export Template

() Update the Target Import/Export Template

|' cancal | | <;_ﬂ Next> |

e Select an option for duplicate import/export templates (i.e., ones that
may already exist in this ICMS system with the same name as those you
are transferring in). You can either ignore duplicates or update existing
templates that have the same name. Then click Next.
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S —
E Rediscovery Transter Imy

Transfer Import/Export Template(s) from Disk

Reviewthe pendingupdate actions to seewhich importfexport templates will beadded,
ignored, andupdated. Clickcancelto abortthe update-noimportfexporttemplateswillbe
added/updated. ClickFinish to complete theupdate.

© Settings Total |
} | Total Incoming Import/Export Templates

|
|_ MNew Import/Export Template to ADD i
|
|

Import/Export Template to IGNORE 1]
Import/Export Template to UPDATE 1]

| Template Name - Sstatus |
u Condition import Mew Import/Export Template to ADD |

Print Report

Lo [ sms] oo | [ rosh

e  The program will display a summary of the import/export templates
being brought in, including their names and whether they will be newly
added or updated. Click Finish.

Reiscovery for the UsS, Department of the Interior ICMS 5

@ Transfer Complete. 1importfexport templates added, 0 import/export templates updated.

e  When the transfer is complete, click OK. The import/export template is
now available for use in your directory.

Functions/Import/Export Selected Fields 8:36 ICMS User Manual (2015)



V. DATA UPDATES (FORMERLY LAPTOP COPY)

A. Overview

1. What is the Data Updates
function?

2. When will I use the Data
Updates function?

3. Do I need special security
rights to use Data Updates?

B. Using Data Updates

1. How do | send records from
one computer to another
using the Data Updates
function?

2. Can | copy subsets of the
data from my laptop?

3. How do | access the Data
Updates function?

ICMS User Manual (2015)

Data Updates (formerly known as Laptop Copy) allows you to create and
update records on remote computers where there is not an available network
connection. After they have been created or updated on a remote computer,
such as a laptop, you can add and update them on your master collection
directory.

Use the Data Updates function to transfer records to your main collection
directory from a remote computer.

For example, you may want to use a laptop to catalog objects in a historic
structure or storage facility. You could then use Data Updates to copy the
records into your master database.

Yes. You need Administrator security rights to use Data Updates. Refer to
Section VI of Chapter 9 for information on user security.

The update process includes two steps, with an optional third step for
permanently removing the records from the remote computer, after they have
been copied to the master database.

e send the records to an Update zip file
e load the records from an Update zip file

e delete the records from the remote system directory (optional)

Yes. The “Send Data to Update Zip File” option allows you to copy the
entire directory or a subset of your catalog records. To copy a subset of your
catalog records, activate a filter, tag set or highlight multiple records in the
List Pane. Refer to Chapter 7 for information on creating tag sets and filters.

Note: For the associated module tables, such as accessions or the other
archives levels, all the records are included in the zip file, not just those
associated with the selected catalog records.

From any catalog screen in Collections or Archives modules, go to the File
menu and select Data Updates. You will see the three options in the
submenu.
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4. How do I copy records to
an update zip file to upload
to another system?

Moving & Sharing Data/Data Updates

To copy records to an update zip file:

Go to the directory that contains the records you want to copy. Note: If
you don’t want to send the entire directory, create a filter, activate a tag
set or highlight multiple records in the List Pane first.

Go to the File menu and choose “Data Updates” then “Send Data to
Update Zip File”

33 Send Data to Update Zip File

Send Data to Update Zip File

Verify options and click 'Start Data Send' to create an update zip file. You can use the resulting zip file in
another systern or directory by utilizing the 'Retrieve Data from Update Zip File' menu option,

Source Directory:

Management Reports

PARK - Archives

PARE - Archives (Trem Level) Location to save the update zip file:
ARE - Cultural Resources Ciltemp

Browse

PARE - Matural History
temp - Archives (4-level)
TEMP - Culural Resources
test? - Matural Histary Default update zip filename:
TESTM - Cultural Resources

TESTHM - Matural History

|v] Use default update zip filename

&) Entire Directary
\J Selected 5 Catalog Records records

Start Dats Send Cancel

Select the directory where your data is located.

If you have activated a tag set, filter or highlighted records in the List
Pane of the current directory, you will have the option to send the Entire
Directory or Selected # of Catalog Records. This applies only to the main
table (catalog records, or collection, series, file unit or item records in
archives.) All associated module data will be sent.

Note: If you choose a different directory from the one you started the Send
Data process, you can only send the entire directory.

Select a location to save the update zip file by typing a path in the
Location field or clicking Browse and selecting a location in the Browse
for Folder window that appears.

The “Use default update zip filename” option allows you to change the
name of the file if desired. When checked, the file will be named
“Update-directory name-current date.zip” where directory name is the
directory you chose and current date is today’s date. Uncheck the option
to enter a different file name. A new entry line will appear for you to
type your own file name.

Click Start Data Send. You will receive a message that this process
could take awhile depending on the amount of data in your directory or
selected records. The update file will include all associated module data
and images from the directory as well as the catalog data you have
selected. You will get a confirmation message when the update file is
complete.
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5. How do I copy records from  To copy records from an update zip file to a directory:
my update zip file to a
directory on another ¢ Go to any directory on the other computer and from File menu, select
computer? “Data Updates” then “Load Data from Update Zip File”.

I Load From Update Zip File - Select Zip File

Load From Update Zip File
Select the incoming update zip file, These files typically have a name like 'Update-{Directory]-
[Date].zip'.

Select the incoming update zip file:

| Browse

Cancel Mext »

e  Enter the path and filename of the incoming update zip file, or click
Browse to locate and select the file. Then click Next.

Example: D:\update-CR_PARK-05-20-2006.zip

I Load From Update Zip File - Select Destination Directory

Load From Update Zip File

Select the directory to update from the list below, Use the 'Create New Directory' link to create
an empty directory of the correct type,

Incoming directory type: Cultural Resources

Select the destination directory:

PAREK - Culural Resources

TESTR - Cultural

Resources

Create New Directary

| Cancel Il < Back Jl ezt =
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e The incoming directory type is displayed with a list of matching
directories available in the system. Highlight the directory to load the
data. You can load the data directly into your master directory or a

temporary directory.

Note: If you want to create a new empty directory to load the data, click
“Create New Directory” (see Chapter 9, Section IV, for information on
creating directories). The new directory will appear in the list for you to

select.

e  (lick Next.

Load From Update Zip File

Check the modules you want to load.

& Load From Update Zip File - Select Module Data to Load

Modules

v Catalog Records
ACCEssions
Conseryation
Exhibits
Loans Qut
Loans In
Maintenance
Deaccessions
Restrictions
Locality
Artist/Maker/Eminent Figure
MNarnes and Addresses
Barcode Module

NAGPRA

Check all Uncheck All

Autormated Inventory Program

Initial data update {no synchronization
date)

Destination directary typically should be
empty. Duplicate records will be
skipped,

< Back_l Mesxt = _-J

e Since all associated module data is included in the update zip file, you
have the opportunity to load any or all of these associated modules at the
same time you load the catalog data. Uncheck those associated modules
that you do not want to load at this time.

Synchronization Date

Modulas
: Catalog Records
| [ accessions
[ conservation
[ Exhibits

[ oans out

=l

Synchronization Oate: 5/23/2006

Duplicate records gt skipped if the
incorming and eststing records were bath
maodifed after the synchronization date,

If the destination directory is an empty directory or has not had a Data Update
(Send to Update zip) performed, there is no synchronization date recorded.
The load function uses this synchronization date to compare duplicate
records. If no synchronization date exists, all duplicate records will be
skipped to prevent overwriting records that were both modified separately.

If, however, you are updating the master directory with records from an
update zip file, the synchronization date will show the last time the data was
sent out to the remote system. This means that duplicate records are skipped
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only if they were both modified after this synchronization date. The system
cannot know which record should be the master record and thus leaves the
record unchanged. Otherwise, matching records will be updated for any

module checked.

e  (Click Next.

e You will see a message that the update will proceed and cannot be
canceled. Depending on how much data is being loaded, this process
may take a long time. Click Yes to proceed with the update.

e A report of incoming records shows which submodules were loaded, how
many records were contained in the incoming data, how many are
ignored, how many are added to the directory, how many are updated,

and how many are skipped.

the update,

Load From Update Zip File

& Load From Update Zip File - Verification

Review the pending update actions to see how many records will be ignored, added, updated,
and skipped For each module. IF records will be skipped, a printable report identifies these
records, Click Cancel to abort the update - no records will be updated. Click Finish to complete

Module
3 .Cataiog Records
| Exhibits
{ Artist/Maker/Eminent ...

Records That Will Be Skipped

i Total Incoming Records | Ignore {no change) Add.

Pending Update Actions for TEMP - Cultural Resources

66
4
Q927

U.pd;ate Skip iboth changed)

4|
2
o

Existing Record '.Updatea Date .Incoming Record .Updated i Date |_J
P4l RED 6/25/2002 PARK 9 RED 6/25/2002
PARK & COMY 6/25/2002 PARK [} COMY 6/25/2002
PARK 7 COMY 6/25/2002 PARK 7 COMY 6/25/2002
PARK g COMY 6/25/2002 PARK g COMY 6/25/2002
= Module: Exhibits
207 1 DFM ElTEITONT 00T 1 DFM ATEITNNT. d
Print Records to Skip Repart
i Cancel J == Back J | | Finish

Total Incoming Records — this is the number of records by module found in

the zip file that you ch

0Se€.

Ignore — an incoming record is ignored if a matching record in the directory
has the same update date as the incoming record. There is no need to update

records that have not changed.

Add — an incoming record will be added to the directory if there is no
matching record already present.

Update — an incoming record will update a matching record only if the
incoming record was changed AND the existing record was not changed after
it was originally sent to the Update zip file. The Synchronization date

8:41
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6. How can | get all the
records to load into the
directory regardless of the
date the record was
modified?

7. When do | use the “Delete
Data from Current
Directory” option?

determines if an existing record was changed after it was sent to the remote
computer. Note: The date that data was sent to an update file is recorded for
that directory. Any changes to the master copy of the record after that date
will prevent the record from being updated from the remote computer copy.

Warning: Any records that have images attached on the master computer
after they have been sent to a remote computer will lose the image
connection when those same records are updated from the remote computer
copy. If, however, images are attached to the records prior to sending them
to the remote computer, when these records are uploaded back into the
master copy, the images will be retained. You can also add images on the
remote computer and these will upload to the master system during the
update.

Skip (both changed) — indicates the number of records where the update date
for both the incoming record and the matching record have changed after the
data was sent to the remote computer originally, or this is the initial data
upload for this directory and no synchronization will occur. The system will
not overwrite records that have changed in both the incoming and destination
directories.

e A report of the skipped records is shown with the existing record on the
left and the incoming record on the right showing the user name and date
for comparison. To print this report, click Print Records to Skip Report.

e  Click Finish to complete the update. You will get a confirmation
message when the update is complete. Click OK.

If you want all the records in the Update zip file to load, create an empty
directory to load them into instead of an existing directory. You can then use
the Transfer function to transfer records into your main directory and update
them regardless of the date on the incoming or target record. See Section I of
this chapter for information about transferring records.

Note: With the transfer function, however, there is no verification process
that prevents matching records from being overwritten that have been
changed separately in both directories.

Use the “Delete Data from Current Directory” option to delete all the records
from a temporary collection directory.

Do not use this function from your main, or host, directory. Use it only to
clear the records from a laptop or remote computer to create an empty
directory. Use “Delete Data from Current Directory” only after you have
loaded the records into your main computer using “Load from Update Zip
File”.
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8. How do | use the “Delete WARNING! WARNING! WARNING!
Data from Current If you use this function after you upload files into your MAIN collection
Directory” option? database, the system will permanently remove your collection records!
There is no way to recover them! Do not use this function on your main

directory and not on the temporary directory until you have completed the
“Send Data to Update Zip File”.

To delete records from a temporary directory:

e Go to any catalog record in the directory where you want to remove all
the collection and associated module records.

e  From the File menu, select “Data Updates” then “Delete Data from
Current Directory”.

*  You will receive a warning message that this process will permanently
delete all data from the current directory without possibility of retrieval.

If you want to proceed, click Yes.

e Youare given one final message with a chance to abort the process.
Click Yes to completely delete the data from the directory.
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VI. LOAD TO EMPTY DIRECTORY

A. Overview

1.

Moving & Sharing Data/Load to Empty Directory 8:44

What is the Load to Empty
Directory function?

Why would | use the Load to

Empty Directory function?

Can | use Load to Empty
Directory for any directory

type?

Does the Load to Empty
Directory include image
files?

Can | compare the catalog
records | load to catalog
records in another
directory?

How do | access the Load to

Empty Directory function?

Do | have to have special
security to access this
function?

Load to Empty Directory

How do I load a backup zip
file to an empty directory?

Load to Empty Directory lets you load a backup zip file created using one of
the Backup Data options (except All databases or Web Catalog transfer) into
an empty data directory. Refer to Chapter 9, Tools, for information on
Backup Data.

The function will check the destination directory, and prompt you to select
another directory if it already has data. This will prevent overwriting existing
data. If the backup contains images or multimedia files, these will also be
loaded into the system maintaining the links between records and
image/media files.

You will need to use the Load to Empty Directory function if you:

e want to load records from a directory backup onto a stand alone machine
such as a laptop

e receive a backup zip file of records from contract catalogers

e receive a backup zip file of records from another unit or center

Yes. The Load to Empty Directory works for any kind of directory: Cultural
Resources, Natural History, and Archives directories.

Yes. If the backup zip file included images when created, you will have the
option in the Load to Empty Directory process to load those image files
along with the records.

Yes. After loading the data to an empty directory, use the Catalog
Comparison option on the Tools menu to compare catalog data between two
collections directories. See below for further information on using the
Catalog Comparison tool.

Load to Empty Directory is located on the File menu.

Yes. You must have Administrator rights to use the Load to Empty
Directory function. See Chapter 9, Tools, for more information on user
security.

To load a backup zip file to an empty directory:

o  Either create a new empty directory of the correct type for the data that
will be loaded (e.g., cultural resources, natural history, archives), or
identify an empty directory to use for this process. You will also have
the opportunity to create a new directory during the loading process.
Refer to Chapter 9, Tools, for information on creating new directories.
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e Select Load to Empty Directory from the File menu to start the Load to
Empty Directory wizard.

&= Load to Empty Directory - Select Zip File

Load to Empty Directory
Select the incoming directory file. This must be a zip file created from a Eé

standard backup or a directory Folder From an earlier version, {Data
from an earlier wersion will be converted if possible, )

Select the incoming data directory file:

Browvise

| Cancel | Mexk =

e Click Browse to select the backup zip file to load. Locate and highlight
the zip file in the Open dialogue box and click Open.

Note: You can only load backup zip files that were created from
Rediscovery’s Backup Data function. If the zip file you select is not the
correct type, a message will appear indicating that the file is not a backup zip
file. You must choose the correct zip file, or use a different process to load
the zip file (such as Data Updates or Transfer from Disk depending on the
type of zip file).

& Load to Empty Directory - Select Zip File

Load to Empty Directory
Select the incoming directary file, This must be a zip file created from a Ei

standard backup or a direckory Folder Fram an earlier version. (Data
from an earlier version will be converted if possible. )

Select the incoming data directory file:
VIR _TEST3-WithImages-5-15-2006.zip Browse

|v| Save incoming images

| Cancel | Mext =

e Ifimages are included in the zip file, you will also have an option to
save the images. If you do not want to save the images from the zip file,
uncheck the “Save incoming images” option.
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e  (Click Next.

Load to Empty Directory, - Select Source Directory

Load to Empty Directory

Incaoming Zip files can conkain mulkiple directaries, Please choose a
directary Fram the list below and click Next,

wrhich directory do you want to load?

Matural History
Trnp3 - Cultural Resources
PARE - Archives (Tkem Lewvel)

| Cancel Jl < Back Jl Mexk = J

e If your backup zip file contains more than one directory, you need to
choose which directory you wish to load. Select the directory from the
zip file that you want to load and click Next.

Note: If the zip file contains only one directory, you will not see this
window. Skip to the next step.

& Load to Empty Directory - Select Destination Directory _||E|[g|

Load to Empty Directory

Select an empty directory from the list and click Finish, Use the 'Create
Mew Directory’ link to create an emply direckory of the correct bvpe,

Incoring directory type: Cultural Resources

Select an empty directory:

PARK - Cultural Resources
TEMP - Cultural Resources

Create Mew Directary

Caneel J l < Back J Finish

e Select the destination directory. You will see a list of available
directories that match the incoming directory type. Select an empty
directory to load the data.

e  (Click Finish.
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2. Canlload a backup zip file
from a previous version of
ICMS?

C. Catalog Comparison
Report

1. What is the Catalog
Comparison report?

2. Why would | use the
Catalog Comparison report?

3. What fields are displayed in
the Catalog Comparison
report?

ICMS User Manual (2015)

e A message will inform you that this process may take a long time
without the option to cancel. The length of time depends on how much
data you are loading and whether there are images or multimedia files.
Click Yes to continue.

e The system will then check to determine if the destination directory is
empty. If the destination directory that you selected is not empty, you
will receive a message that the data could not be loaded because the
destination directory is not empty. Click OK. You should then do one
of the following:

—  Select another empty directory from the list, or

—  Click Create New Directory to create an empty directory. (See
Chapter 9, Tools, for information on creating directories.) After
creating the directory, you will see the new directory appear in the
list. Select it and click Finish again.

e  After the data has finished loading, you will receive a confirmation
message that it loaded successfully. Click OK. Your data has now been
loaded to the selected directory and is available for use.

If this is data you received from a contract cataloger, other unit or center,
you will want to review the records and then transfer them to your main
directory. Refer to Section I of this chapter for information on
transferring records to another directory.

Once the records have been transferred, you can delete this directory. See
Chapter 9, Tools, for information on deleting a directory.

Yes. You can load a backup from ICMS 8.10 and later -- it will
automatically be upgraded during the load process.

The Catalog Comparison report compares specific fields between matching
catalog numbers for two selected collections directories. This is a useful
tool if you receive data from a contractor or center and want to compare it
with your main catalog records.

You may want to compare data between directories to:

e determine if a temporary directory’s catalog records have been
transferred to your main directory,

e  check for duplicate cataloging between like directories,

e check if existing records were changed by a contractor or center.

The Catalog Comparison report compares the following fields between
matching catalog numbers found in a master directory and another directory:

Catalog #
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4. How do I run the Catalog
Comparison report?

Accession #
Item Count
Item Quantity
Object

Log Date

To run the Catalog Comparison report,

e Select Catalog Comparison from the Tools menu.

= Catalog Comparison - Select Directories for co

Catalog Comparison

Select Directories to compare from the lisks below

mparison

To restrict the "Master” directory to one park, ente

Zelect a folder where reports should be saved:
Ciicatalog files

Master directory:
DOl - Cultural Resources
PARK - Cultural Resources

TEMP - Cultural Resources
DOl - Matural Hiskory
PARK - Matural History
DOl - Archives {(4-level)
PARK - Archives (4-level)

r Park acronym:

Browse

Directory to be compared to the Master;
DOl - Cultural Resources
PARK - Cultural Resources
TEMP - Cultural Resources
DOl - Matural Hiskory
PARK - Matural History
DOl - Archives {(4-level)
PARK - Archives (4-level)

| Cancel

| Mext =

e  (For NPS style directories) If the master directory contains data for more
than one park, you can limit the catalog records to a specific park by
entering the acronym for that park. Otherwise, leave this field blank to
compare all data in the master directory.

e Enter a location to save the report.

Or, click Browse to select the folder.

e  For the Master directory, select the directory with the least number of
records. Generally, this will be the temporary directory that you loaded.
Note: By selecting the directory with the least number of records as the
Master directory, the report will be shorter because it will not list as
many catalog records with no matching records in the comparison

directory.

e  For the directory to be compared t

o the master, select your main

collections directory. Note: you can only compare records between the

same directory types: Cultural Re

e  (Click Next.
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5. How do I print the Catalog
Comparison report?

ICMS User Manual (2015)

= Catalog Comparison - View Catalog Comparison Report

Catalog Comparison

Catalog Comparisan Report

Catalog Comparison 12/16/2009

Prink Report
Master Directory: TEMP - Cultural Resources Directory for Comparison: PARK - Cultural Done.
Resources [

Catalog# | Access# |Cnt Qty  Object Log Dte |Catalog#| Access# Cnt Qty Object Log Dte

|PARK- PROJECTILE |PARK- |
PARK 468 00426 1.00/0.00 POINT 03/28/1994 PARK 468 00426 1.00 |0.00 FLAKE 03/28/1994

PARK- | 1 \ PARK- |
PARK 469 00436 2.00 0.00 SPALL 03/28/1994 PARK 469 00436 1.00|0.00 |SPALL |03/28/1994
PARK PARK-
33401 00579 1.00/0.00 BOW 12/16/2009 |No Record

| Cancel | =Back | Finish

The left side of the report lists the catalog records from the Master directory
that you selected that either differ from the comparison directory or do not
have a matching record in the comparison directory. The right side of the
report lists any matching catalog records with the data that differs bolded.

For example, in the above report, the temporary directory on the left lists two
catalog records that have a matching catalog number in the comparison
directory but whose data differ. The first record has a different Object name
between the two directories. The second record has a different item count.

The third catalog record listed for the temporary directory on the left has no
matching catalog record in the comparison directory.

To print the report,

e  click the Print Report link in the upper right corner.

Page Setup E|
Paper Optiohs Margins [inches)
Page Size Left:

v Rigrt

() Portrait (O Landscape Top: 075

[ Print Backaround Colors and Images Batiom: ’W‘ ____________
Enable Shrink-to-Fit

Headers and Footers

Header: Eooter:

Tite v| [uRL ~|
‘ -Emply- i | | Empty- - |
‘ Page # of total pages R4 | | Date in short farmat £ |

e Select the page setup options as desired. You can select the paper size,
orientation and margins. You can also include header and footer
information for the report as well as change the font.

e Click OK. Your printer dialog box will open for you to select the
printer.

e  Click Finish on the Catalog Comparison report preview window.
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